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Example #2: Slurry-fed ceramic

melter monitoring




Slurry-fed glass melter

" High temperature glass fusion in a slurry-fed glass
melter

* nuclear waste stabilization in the glass
* the product is stable for long time

" Objective: development of a monitoring system of
the process
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=" Data X:

e 450 observations

e 21 variables:
o temperatures in 20 points of the melter
o glass level

" | oad:
* load replacedata

" Data visualization: o e
* nho anomalies seem to be present -
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Exploratory and monitoring model

= PCA model calibration on «standard» process data (normal operating
conditions NOC)
e choice of the number A of PCs
* loadings analysis to study variables correlations
e scores analysis to study observation relations

= Multivariate monitoring of unknown observations:

e statistical monitoring chart
o T? Hotelling chart
o Qresiduals chart
e anomalies detection:
o confidence limits
 anomalies diagnosis
o contribution plots
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Choice of the PCA model dimension

= Autoscaling and PCA model calibration

" Choice of the PCs number:
e cumulative variance: PCs > 8/9 do not add information

* eigenvalues < 1 at PC5
* cross validation: min(RMSECV') for PC7

robust method

4

Prncipal Component Nurmber PicpalComponentNumber . princal Component Number

—
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Cross validation

= Jackknife procedure for testing how the including too much P
model works on new unknown data: u -

overfitting, namely,
 allows understanding the optimal model .l modelling t ise
complexity e RMSEC)
* method:

O science-based I '
o robust L

o credible

nnnnnnnnnnnnnnnnnnnnnnnn

Venetian Blinds Contiguous Blocks Random Subsets Leave-One Out

Test sample
selection scheme
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Exploratory analysis

= \/ariables correlation:
* loading plot

= Relation among observations:
e score plot
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Sample diagnostics

" () residuals (squared prediction error SPE)

* orthogonal distance between a new observation X,
and the model

* high Q = a new event happened (with a new
correlation structure)

* () measures the variability that is not captured by

new observation

the model
. X3
= Hotelling T
. . . X
» weighted distance from the average condition on 1
calibration A
o weighted on the variance explained by each PC Tii =ty Ay = z af’“
a=1 ¢

* high T? = too high variability with respect to the
average calibration conditions

—el .e
* T2 in a measure of the variability within the model One1 = enerlni
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Confidence limits

* Hotelling T2
* the limit comes from a F distribution of:
5 AN —1)
Tllm — N . A FA,N—A,l—CZ

" Qresiduals
* the limit comes from a y? distribution of

Sé

Qlim = X%
) “Hq .
,LLQ 5(22 11—«

" 5% of out of limits must be accepted

* the outliers should be removed only if an anomaly is
present

Prof. Pierantonio Facco - Machine learning for process engineering

|
95% coinfidence lim

it

! ! !
0 0

.....




Monitoring system validation #1




New observation monitoring: validation #1

" | oad validation dataset: reptestl

[4] Analysis - PCA 7 PCs - SFCM Calibration Data - [m} X

File Edit Preprocess Analysis Refine Tools Help FigBrowser N
Load Data > Calibration

importData i X-Block X | [Ecache : "general" DATE View (* = Not Available) X
Newbat ’| Y-Block Analysis Flowchart +8 Cache Settings and View
Load Model Load X and Y . '+ Demo Data
Import Model Valiaton ' | 1. Load calibration data ‘ +102-Jul-2017
Load Prediction X-Block i . +01-Jul-2017
Load Options Y-Block Apply [ Valicate ‘ 2. Choose Preprocessing ‘ +128-Jun-2017
Save Data s LoadXandY | | ‘ 3. Choose Cross-Validation ‘ 20 Jun-2017
Save Model Auto Select H15-Jun-2017
Export Model > Percent Variance Captured by PCA Model (* = suggested) 4. Build Model ‘ 7;?2_:\;1”_233177
Export Predictions > jii16-May-
Sase e RMSEC RMSECV Review Model 116-May-2017
Save Options 37 36.37 0.7968 0.8355 suggested A 5127—Apr—20’l7
?25 66.62 0.5771 0.6238 ‘ 5. Choose Components ‘ :]197Apr720’l7
13 76.75 0.4817 0.5626 +07-Apr-2017
Ao 2 8547 0.3808 0.4802 ‘ 6. Review Scores ‘ +104-Apr-2017
5 8.20e-01 3.90 89.37 0.3257 0.4421 ‘ 7. i sl ‘
6 6.15e-01 2.93 92.30 0.2772 0.4266 - Review Loadings
7lB21e01 200 9430 0238 0416 current Use Model -
8 3.07e-01 1.46 95.77 0.2055 0.4721
9 2.30e-01 1.10 96.86 0.177 0.5249 ‘ 8. Load Test Data ‘
70 1.85e-01 0.88 97.74 0.1501 0.5872
11 1.30e-01 0.62 98.36 0.1278 0.6032 9. Apply Model ‘
12 9.54e-02 0.45 98.82 0.1086 0.6351
13 7.71e-02 0.37 99.18 0.09023 0.6556
74 6.25e-02 0.30 99.48 0.07191 0.9662
15 4.41e-02 0.21 99.69 0.05548 1.013
16 2.44e-02 0.12 99.81 0.04381 1.115
17 1.86e-02 0.09 99.90 0.03215 2.529
18 8.86e-03 0.04 99.94 0.02476 3.756
79 8.05e-03 0.04 99.98 0.01518 6.857 &
L]
A model has been calibrated from the data. Review the model using the toolbar button(s), save the A
model (File menu), or load test (validation) data (File menu). The number of components,
preprocessing options, and other settings can also be modified to adjust the model. The data can
be viewed and edited from the Edit menu. v
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Validation observation #1

* New data x,,, is projected onto the hyperplane of the PCs:
tvi1 = Xy+1P

" The coordinates of the new observation in the PCs space are obtained

" Observe if the Hotelling and Q indices are well within the confidence limits
obtained from the NOC calibration data
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Process monitoring

= Anomalies are detected for:
e observation 33 »
e observation 50-54

diagnosis is needed!

anomalies

ssssssssssss
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Diagnosis of anomalies: contribution plots for obs. 33

[# Analysis - PCA 7 PCs - SFCM Calibration Data ) L — O X
|| Figure 1: Samples/Scores - PCA 7 PCs - SECM Calibration Data = O X
Do 5 Ap FigBrowser | . | (4] Figure 2: Samples/Scores - PCA 7 PCs - SFCM Calibration Data - | X >
File Edit View Plot FigBrowser File Edit View Insert Tools Desktop Window Help FigBrowser PlotGUI k]
‘ ‘ Dﬁﬂg‘ R(‘""” Mm®E - DE‘.@ ew (* = Not Available) x|
Fig 2: Samples/Scores - ... v = T ol 27
— ‘ o7 228X B 00 TR A K ' ‘
ample v
SCOIes O U 7 (2007 C|ICk and drag to draw selection box. Abort by pressing [Esc]. ‘
Y Q Residuals 45 T T T T T T T T T T
Hotelling T2 l
40
NumberPCs  Hotelling TA2 Reduced
7 KNN Score Distance (kv tured by PCA Model ( 2 I h I I
< > 5361 . select the relevant sampie
0
S [s)) —
1 7.64e+( ZNONE ] S gl
2 635+ Color By... | =
3 2.13e+ 3
- Plot | Plot Type... | o5t
4 1.83e+ 3
Q o o
5 8.20e-C Select | Tool | € g0t Autoscale] 2017-04-04 11:04:22.79
6 6.15e-0 T
7 Qcon | Q con Ref. | 3 i Autoscale] 2017-04-04 11:04:14.60
8 3.07e-0 T con Ref. 0.2055 é
9 2.30e-0 - 0.177 o 10
10 1.85€-0 e 0.1501
77 1.30e-0 Data with Test 0.1278 7.3947
12 9.54e-C 0.1086 St
13 7.71e-Q 009023 | | e
145254 oo, T5 0 15 0 25 w0387 4 a5 s
15 4.41e-02 0.2 5! h
€ 1 C"Ck g(f CO"W ”g,_t e Sample
16 2.44e-02 0.04381
17 1.86e-02 m aﬁ Ig 2.529
18 8.86e-03 (( Ot C tro 76 3.756
19 8059’03 faWaVl 00(& 0. 0N1C10 I~ &E7 v
n
The model had been calibrated from the calibration data and applied to the test (validation) data. A
Review the prediction results using the Toolbars buttons. The number of components,
preprocessing options, and other settings can also be modified to adjust the model. The data can
be viewed and edited from the Edit menu. v
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Diagnosis of the anomaly at obs. 33

= Contribution plots are used for N
diagnosis | g
* this diagnosis tool do not find the
CAUSE of the anomaly, but the
variables which are most

correlated to the causes of the
malfunction!!!

Variable
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Improved diagnosis of the anomalies

= Contribution plots are used for diagnosis in an improved way if you build a
contribution plot chart with the respective confidence limits:

* the confidence limits on the contributions on T4 or SPE are based on the assumption
that scores and residuals are normally distributed

* under this hypothesis it is easy to build a sort of Shewhart chart on each variable with
the respective 95% confidence limits

1. calculate the mean and standard deviation of each contribution (either of T2 or SPE) for the
calibration data

2. verify if the mean are sufficiently close to zero
3. calculate the 95% (i.e., +1.960) confidence limits
4. compare the contribution of each variable for new projected observations to the respective limit
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Improved diagnosis of the anomaly at obs. 33

-

* The improved diagnosis tell us much
more: the issue here is related to :
more than one variable!

* variable 9 is highly deviating
e variables 5, 6, 7, 16, 17 and 21 are too

SPE contribution

high
e variables 3 and 13 are too low 95% confidence limits
on SPE contributions \
5 L | /
0 5 10" 15 20

variables
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Monitoring system validation #2




New observation monitoring: validation #2

" Load dataset: reptest2

= Score plot: calibration + validation:
* validation set shows different mean with respect to calibration
* new process conditions are found

mmmmmmmmmmmmmm
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Take home message

= Multivariate statistic process monitoring utilizes complementary monitoring
charts that must be observed together

* Hotelling T4
e squared prediction error Q

= Both of them must be overviewed at the same time!

= Control charts detect malfunctions

e and subtle phenomena as well
o drifts
o seasonal effects

" The malfunctions causes can be diagnosed studying the variables which are
most correlated to the anomaly
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Matlab® code

clear all
close all

clc
load replacedata

Xc=double(repcal);
Xvl=double(reptestl);
Xv2=double(reptest2);

% Data visualization
figure;plot(Xc(:,1:2),'DisplayName','X(:,1:2)');xlabel('sample');ylabel(‘temperature [°C]");
figure;plot(Xc(:,1:3),'DisplayName’,'X(:,1:3)");xlabel('sample’);ylabel(‘temperature [°C]");
figure;plot(Xc(:,4:6),'DisplayName’,'X(:,4:6)");xlabel('sample');ylabel(‘temperature [°C]');
figure;scatter(Xc(:,1),Xc(:,2));xlabel('temperature 1 [°C]");ylabel(‘temperature 2 [°C]');box on;
figure;scatter(Xc(:,1),Xc(:,3));xlabel('temperature 1 [°C]");ylabel(‘temperature 3 [°C]');box on;

figure;scatter(Xc(:,1),Xc(:,11));xlabel('temperature 1 [°C]');ylabel('temperature 11 [°C]');box on;

Cc7_8=corrcoef(Xc(:,7:8));

Cm=corrcoef(Xc);

corrmap(Xc);

figure;imagesc(corrcoef(Xc));xlabel('variables');ylabel('variables’);
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Matlab® code

% PCA model building
opca.display="off";
opca.plots='none’;
opca.preprocessing='autoscale’;

pcam=pca(Xc,7,0pca);

% Verification of the monitoring charts performances
T2=pcam.tsqs{1,1};

Q=pcam.ssqresiduals{1,1};
T2lim=pcam.tsqlim{1,1}(1,1);
Qlim=pcam.reslim{1,1}(1,1);
sum(T2>T2lim)/length(Xc)

sum(Q>Qlim)/length(Xc)

% Verification of the residuals
T=pcam.loads{1,1};
P=pcam.loads{2,1};
E=auto(Xc)-T*P';
histogram(E(:,1))

histogram(E)
normplot(E(:,1))
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Matlab® code

% Verification of the control limits
T2lim2=7*449/(450-7)*finv(0.95,7,451-7);
Qlim_chi=chilimit(Q);
Qlim_jm=jmlimit(7,pcam.detail.ssq(:,2),0.95)
sQ=std(Q);

mQ=mean(Q);

Qlim_chi2=sQ*2/(2*mQ)*chi2inv(0.95,round(2*mQ/sQ"2))

% Projection of the validation data
[Tvi,Qv1,T2v1]=pcapro(Xvl,pcam,0);
[Tv2,Qv2,T2v2]=pcapro(Xv2,pcam,0);

% Contribution plots for diagnosis
T2conC=tconcalc(Xc,pcam);

QconC=gconcalc(Xc,pcam);

figure;hist(T2conC(:,1))
figure;normplot(T2conC(:,1))
figure;hist(T2conC(:,3))
figure;hist(QconC(:,1))
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Matlab® code

mT2c=mean(T2conC);
sT2c=std(T2conC);
mQc=mean(QconC);
sQc=std(QconC);

T2conV1=tconcalc(Xvl,pcam);
figure;bar(T2conV1(1,:));hold on;plot(mT2c-2*sT2c,'--m');plot(mT2c+2*sT2c,'--m');hold off;xlabel('variable');ylabel('TA2 contribuution');title('validation 1 - observation 1')
giglt;re;bar(T2conV1(28,:));hoId on;plot(mT2c-2*sT2c,'--m');plot(mT2c+2*sT2c¢,'--m');hold off;xlabel('variable');ylabel('TA2 contribuution');title('validation 1 - observation

QconV1=qgconcalc(Xvl,pcam);

figure;bar(QconV1(1,:));hold on;plot(mQc-2*sQc,'--m'); plot(mQc+2*sQc,'--m');hold off;xlabel('variable');ylabel('Q contribuution');title('validation 1 - observation 1')
figure;bar(QconV1(50,:));hold on;plot(mQc-2*sQc,'--m'); plot(mQc+2*sQc,'--m');hold off;xlabel('variable');ylabel('Q contribuution');title('validation 1 - observation 50')
figure;bar(QconV1(51,:));hold on;plot(mQc-2*sQc,'--m'); plot(mQc+2*sQc,'--m');hold off;xlabel('variable');ylabel('Q contribuution');title('validation 1 - observation 51')
figure;bar(QconV1(54,:));hold on;plot(mQc-2*sQc,'--m'); plot(mQc+2*sQc,'--m');hold off;xlabel('variable');ylabel('Q contribuution');title('validation 1 - observation 54')
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... per sempre a fianco a me!
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